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By:Vimalesh Narayan Read More...

By Vimalesh Narayan / On : Monday, April 20, 2009/ Thank you for visiting my blog. contact me at admin@countertriketutes.com

Note: This tutorial is an original work of SuperJer.com  and All the credits belongs to him only  also the article is mentioned
on this site to make people more aware of the process of making CS 1.6 maps without of a much difficulty..! No modifications
are being made in the article.

Courtsey: All credits to SuperJer.com for making this wonderful tutorial ..!

How to make Counter Strike (CS ) 1.6 Map .... ?

Get Learned!TUTORIAL
"I want to make CS maps but don't know where to start!"

I hear this all the time. And instead of kicking people in the face and throwing them in the gutter for trying to talk to me, I
thought I'd change my ways and write this little helpy page. Note: this is for people who have ABSOLUTELY no clue about
making maps for HL or HL mods. So, if that is you, and you need to be told what to do, read on, little doggy! 

This guide is NOT for CS:Source or HL2 etc. 

If you have less time watch the video

This guide IS for original Counter-Strike (v1.6 or older). However, it is a good starting point to learn to map for similar games.

Step 1 - Get the DopeINSTALL
You can't make something out of nothing, so grab yourself a shiny new copy of the "Valve Hammer Editor" and also get the
"ZHLT Compilers". These are absolutely required to make maps for HL games. 

Direct link to Hammer Editor (v3.4)
Direct link to ZHLT Compilers (v2.53r17)

The Valve Hammer Editor, henceforth referred to as "Teh Hammre" is what you will use to physically build your map. With it
you decide the placement of walls, textures, player starts etc.. ZHLT converts, or compiles your map so that Half-Life can
load and play it.

Install Teh Hammre and start the program. Click NO when it asks you something upon starting up. You should look at the
help guide later but for now it has too much information all at once. Then you should see something similar to this:

.

..::DOWNLOAD NOW::..

SERVER PATCH 2011

Weapon Restriction and Control Plugins.zip

Music Plugins.zip

Match Plugins.zip

Punishment Plugins.zip

Command n Rules Plugins.zip

Configurations.zip

Announcement Plugins.zip

AMX MEGA Plugins.zip

Background Changer.zip

$1.99

Counter-Strike:
Source - PC

$6.28

Counter-Strike 1
Anthology - PC

$5.99

Half-Life:
Counter-Strike...
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rgodfan

Best Counter Strike Tutorials
2009-2011...steam,online,1.6
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It's time to configure!

Get Learned! Step 2 - Plug It InCONFIGURE

Many new users of Teh Hammre are so scared by the configuring process that they run away, never to come back. There's a
TON of stuff to set up! The trick is that you can ignore most of it, so here's all you need to do: 

1) Click the Game Configurations tab
2) Click the Edit button
3) Click the Add button in the dialog that pops up
4) Type "cstrike" in the textbox
5) Click the OK button
6) Click Close
7) Now click the Add button on the big Configure window
8) Add the file called "halflife-cs.fgd" ..Locationof fgd file?...  or Download halflife-cs.fgd here...Google will get directories
listed...open anyne and download .fgd file ....Else  get this
9) Click the Textures tab
10) Click the Add WAD button
11) Add the file called "cstrike.wad" Location of wad file? or  Download cstrike .wad FILE
12) All done -- click OK to close the big Configure window

You can get back to the Configure window by selecting Tools->Options from the menu bar. You should go there and look
around once you are familiar with map design.

If you completed everything on this page, you're now ready to start building!

Get Learned! Step 3 - Buildin' BlocksBRUSHES
You should have Teh Hammre open, so now select File->New from the menu bar. You should now see 4 big black rectangles,
or viewports, labelled camera, top, front and side. To the right, you should see a panel that looks like this:

That panel shows what texture is currently
selected. A texture is a picture that is
plastered onto a wall, floor, ceiling, or
surface in a 3d game. You've probably
seen them before. You can choose a new
texture by clicking the Browse button. It
will display a list of all the textures you
have loaded right now. (Remember
opening the file 'cstrike.wad'? That's where
these textures came from.) 

Once you have selected a texture that
makes your heart filled with gladness, click
the button on the left that looks like this:

This is
the
brush
creation
tool. A
brush is
a 3d
chunk
of
space
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defined by a few surfaces. For example, a
cube is defined by 6 surfaces or planes.
Move your mouse pointer over the

viewport labelled 'top'. It should look like a plus with a fuzzy rectangle. Now click and drag on the grid in the top viewport to
draw a rectangle. When you let go of the drag, the rectangle should turn white and 8 little white handles should appear
around it. You can use the handles to resize your rectangle.

KEY POINT: Look at the other viewpoints. Your rectangle is actually a 3d box! Isn't that rad? What you need to get used to is
looking at a 3d object from different 2d views. If you can master that, you'll be able to create just about anything you like!

Now notice that you can resize your box in all 3 viewports. This may not seem important now, but when you are building a
complex shape later, this is super-duper useful. Also try clicking inside your box and dragging it. This is how you move it
around. 

Now hit Enter on your keyboard. Your box should have turned blue or green, meaning it actually exists now. Before it was just
a plan. You can click on your box, or brush, like I said earlier, and it will turn red. In Hammer, when something is red, that
means it is selected. You can resize and move selected brushes just like you did before. 

Now glue on your wings because it's time to get to the next page, Sally!

Get Learned! Step 4 - Learn to FlyCAMERAS

See that big juicy red button that looks like this?

That's the camera button, and we're going to use it to look at stuff! So click it and enter
camera mode. In camera mode you can't move brushes around, you can only look around.
So, hold shift and click and drag in the top viewport from A to B as shown:

That's how you create a new camera. The blue circle is
the eye and the red line is the direction of sight. By
clicking on either end you can move them around. To
delete a camera, just press Delete on your keyboard
while it is selected (red). 

If you created your camera correctly, you should see a
3d box in the upper left viewport like this:

If you don't see it, look in your top, front and side viewports to make sure that the line of
sight is pointing from the eye to your brush. If you STILL can't see it, make sure your
camera isn't too close to your brush. Don't read further until you can see your brush in 3d! 

If you can see your brush in 3d, left click and hold in the 3d viewport and move the mouse
around A LITTLE BIT. This is how you turn the camera view, or look around. 

Now RIGHT click and hold in the 3d view and move the mouse A LITTLE BIT. This is how
you move the camera in it's plane of vision -- any direction but forward. Get used to this
and then continue reading. 

Ok, now here's where it gets wild, LEFT AND RIGHT click at the SAME TIME and hold in the 3d view and move the mouse.
This is how you move forward. 

These controls may seem odd but once you get used to them you'll be able to fly around your map with the greatest of ease.
The reason why I told you to move the mouse A LITTLE BIT is because if you move too much you can get lost in the scary
blackness. If this happens to you, just create a new camera in the top viewport that is pointing at something to look at. 

Now that you can fly, let's build a room...

Get Learned! Step 5 - PlumbingLEAK PROTECTION

Before I explain what a leak is, why don't you click where it says camera in the 3d view and select 3D textured: 

You should now see that your brush is wall-papered with that texture you picked earlier.
You can click any of the viewport labels to change what each view is, but don't worry about
that now. Back to the main subject, here's the most important point of all this:

Your job as a mapper is to build a 3d container that holds water (or beer). 

Stunned? Let me explain. Think of brushes as solid blocks of wood you can glue together
and build stuff with in real life. Now whatever you build, we're going to magically fill it with
precious, precious beer. Then we're going to turn it upside down and shake it around A

LOT. If any of the beer comes out, you have a leak. LEAKS ARE BAD. The biggest problem beginners have is leaks. 

Take a look at this box, maybe it's going to be a room in a Counter-Strike map: 

It's got an open top, and that's not good. You know why? The beer! We're going to lose the
beer! All we need to do is slide a brush on top to seal up the room:

Only in picture 3 is the beer going to be safe. No matter
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what shape map you make it has to be all sealed up
with NO leaks. Example: 

Check it out! This
complicated system
of rooms and
hallways is just a
bunch of brushes
sitting in the right
places. I made it by
positioning each one
where you see it: 

Now I want you to just build a single squarish room. So first, click on this button:

That's the selection tool -- it's what you were using after
you created your brush, when you moved it and
stretched it. Now click on your brush to select it (in 3d
or 2d view). It should turn red. Use the white handles in
the 2d views to make it square and flat. It's going to be
your floor. 

It might be helpful to know that you can use the + and -
keys on the FAR RIGHT EDGE of your keyboard to
zoom in and out in the 2d views. Just put your mouse
pointer over a 2d viewport and press keypad + or -. 

Remember how you could move your brush by clicking on it (not the handles) and dragging it around? Try this: hold shift,
click on your brush and move it to a different spot, then let go. You have to be holding shift when you let go on the mouse. If
you do it right, you will have made a copy of your brush. Take this copy, and using the white handles, resize and move it to
make a wall like this:

Once you have done that, keep copying the wall to make the 3 other walls. Then copy the
floor, and make a ceiling out of it. Be careful that you don't just move the originals! You
need to COPY them -- it's easy to mess up. 

When you're done, you should have something similar to the closed beer-box above. Try
to move your camera into your room and look around. Then get ready for Step 6!

Get Learned! Step 6 - SprinklesENTITIES

Before we sprinkle some entities onto your map, let me show you one more thing about
textures. Click the Browse button in the upper right by the little picture of the texture you picked earlier. Select a different
looking texture. Then (in selection mode, not camera mode), click on your floor brush. Once it's turned red, click this button:

As you hopefully noticed, this button applies the current texture to the selected brush(es).
By the way, you can select more than one brush by holding Ctrl while clicking on brushes.
Also, if you click in a 2d view, but not on a brush, and drag, you can make a selection box.
When you hit enter, any brushes inside the box will turn red (selected). You should try this
out a bit. 

Back to business: we need to create a start point or two. Preferably one for CT and one for
T. This is going to be pretty easy so just click the ugly light bulb of justice:

This is the entity creation tool. Now, if you look to the
right, you should see a panel like this:

In the listbox titled
Objects, or where it
says
'ambient_generic' in
the picture, choose
'info_player_start'.
info_player_start is
the CT start point
entity. An entity is an
object you can place
in your map that has

some special meaning to the game. Wherever you place info_player_start's is where each CT will start at the beginning of a
round of Counter-Strike. 

Now move your mouse pointer over the top 2d viewport. Your pointer should look like a creepy plus with an axe. Click inside
your room and this will make a little green square with lines sticking out of it -- a locator. Make sure the locator is inside your
room in ALL THREE 2D VIEWS. Then hit Enter on your keyboard. Now you should have a tall green box -- about the size of
a Counter-Terrorist. As long as it is completely inside the room, you are ok. You can move it around with the selection tool
(red arrow). Make sure it is not touching the floor or walls or ceiling because then the player will be stuck! It's ok if it's floating
in the air. It's not ok if it's outside the room in invalid space because that is another way to get a LEAK error. 

Now create another entity, but this time make an info_player_deathmatch. This is the Terrorist start point entity. In a real map
you'd want 16 or so of each kind, but for this map 1 each is ok. 
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Now for the last addition to your map: a light source. It's another entity so choose 'light' from the Objects listbox. Put this
inside your room as well, maybe near the ceiling. A light entity is just an invisible dot that radiates a little sunshine. You won't
see a light fixture or anything inside the game -- you'd have to build that out of brushes. 

Your light should look like a little pink box, and you know what we do to little pink boxes, right? We click on them! And they
turn red! Once you have done this, press Alt-Enter. Alt-Enter is keyboard speak for "show me the properties!" This works all
over the place, not just Hammer. Try clicking on a file in windows and pressing Alt-Enter. 

Anyway, you should see this now:

Notice the list of attributes. All entities have some attributes and some entities have lots.
Click on Brightness. The value should be 255 255 128 200. The first three numbers are
the color (yellow in this case) and the fourth number is the brightness. Leave the
brightness alone but use the Pick color button to pick some god-awful color for your light
to shine. When your're done, close the Object Properties window and save your map with
File->Save. 

I don't care where you save your map but don't close Hammer, just minimize it. (Don't use
spaces in your map name.) Then continue:

Get Learned! Step 7 - Finish LineCOMPILE & PLAY

In Step 1 I told you to download the ZHLT Windows executables. That file should be a ZIP file so go ahead and extract all the
files in it to a new folder on your hard drive. A good place for this is:

c:\zhlt\ 

Open that folder so you are looking at the contents:

If you do not see file extensions on your files, like the '.exe', '.txt' above, then click here
it's very important!

As shown in the picture, create a new text document by right clicking in the white-space
and then using the pop-up menu. Name the file 'mapname.bat' where mapname is what
you decided to call your map. 

Go back into Hammer and click File->Export to .MAP. Save you map as 'mapname.map' in
the folder where you just created 'mapname.bat'. Then close Hammer and go back to the

folder where 'mapname.bat' is. 

Now right click on 'mapname.bat' and choose Edit. This should cause Notepad to open with nothing in it. Type the following
stuff into the document exactly as shown, replacing 'mapname' with whatever name you are actually using:

Without Steam
@echo off
hlcsg -nowadtextures mapname
hlbsp mapname
hlvis mapname
hlrad mapname
copy mapname.bsp "C:\half-life\cstrike\maps"
cd C:\half-life
pause
hl -dev -console -game cstrike +sv_cheats 1 +map mapname

"C:\half-life" may not be the correct location of Half-Life on your computer. Make sure you type the correct location on both
the lines where it says that. 

With Steam
@echo off
hlcsg -nowadtextures mapname
hlbsp mapname
hlvis mapname
hlrad mapname
copy mapname.bsp "C:\Steam\SteamApps\EMAIL\counter-strike\cstrike\maps"
pause
"C:\Steam\Steam.exe" -applaunch 10 -dev +sv_cheats 1 +map mapname

"C:\Steam" may not be the correct location of Steam on your computer. Make sure you type the correct location on both the
lines where it says that. Also replace "EMAIL" with your account name. And if you do not have a "maps" folder, create one. 

When you're sure you have it right, save the file and close Notepad. Then double click on the file 'mapname.bat' to run it.
Lot's of confusing stuff will show up in a command window as ZHLT compiles your map. When it is done you will see (at the
bottom): 

Press any key to continue . . . 

Now do NOT press a key! First make sure nothing went wrong. Look in the folder where 'mapname.bat' is and if you see a
new file called 'mapname.err' then your map FAILED to compile. If it failed, click here. Otherwise you can continue. 

Go back to the command window and press any key. Counter-Strike will start and load your map in singleplayer mode. You
will be able to use cheats like noclip and god and impulse 101 for testing. Try them! (You won't have a gun or anything until
you type impulse 101 in the console.) 

That's it! You've made your first map. Ain't you one special duckling! 

Read the Appendix for guidance on where to go next!
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Get Learned! AppendixSUGGESTIONS & WARNINGS
Tons of tutorials and useful information can be found by googling these sites: 

The Valve ERC
The VERC Collective
EditLife

If you are having a problem, believe me that thousands of people have had it before and discussed it on the following forums.
Use the search feature to find old discussions that may answer your questions. Only post a new question if you can't find an
answer through searching. Then other forum-goers will be glad to help you! 

VERC Forums
EditLife Forums

Read the Help inside Hammer! It's surprisingly helpful. Don't forget to use the Index and Search tabs. 

Using search engines like Google and Yahoo is a good idea, too, especially if you know basically what you are looking for. If
you want to know how to make a sky in your map, try searching for "worldcraft half-life sky" (remember that Hammer is aka
Worldcraft). 

Finally, here is a list of miscellaneous things I think you should know. 
Remember to save your map as a .map file in your compile folder before compiling each time. 
Periodically save backups of your map in case you mess it up. You'll be glad you did. 
In Hammer, press the [ and ] keys to change the fineness of the 2d grid. Use a big grid size to make walls and floors etc..
Use a fine grid to make detailed objects. 
ALWAYS USE THE BIGGEST REASONABLE GRID SIZE for what you are building. This has many advantages: 
Less likely to get leaks. 
Map stays clean and easy to edit. 
Faster compile times. 
Don't use flashing lights much ever. They are very annoying even if you think they're cool when you first try them. 
Lights in the real world are almost always white/offwhite/a little yellowy. Use colored lights carefully and only where they
make sense. Newbies use too many colored lights. 
Sunlight is ALWAYS white. Solid bright white light. The only exception is when sunlight enters the atmosphere at such a low
angle that there is some slight pink or orange distortion. 
Moonlight is NOT blue. Ever. It is low intensity white light. 
Learn about the ZHLT compilers. They have lots of sweet options. 
And learn to use texture lights instead of light entities! 

Thanks for playing and good luck! 

Update! Learn how to make ladders and more here!

Note: The article is published for CS 1.6 Geeks interest and  If You have any Problem with this publication , let me know and
i will remove it on priority basis.

Thanks to Superjer.com

from

CounterStriketutes.blogspot.com Team

AT MONDAY, A PRIL 20,  2009

RE ACTIONS:

3 2  C O M M E N T S :

Anonymous said...

halflife-cs.fdg link doesn't work with me :/ Opens a page with a adobe shockwave player is shown and doesn't load

anything... :/ :/ :/

APRIL 24,  2009 AT 4:55 PM

Anonymous said...

I did everything like the tutorial told to do but when I press any key it opens CS but does nothing after that. I can't find

the map in new game or any mymapname.err file. HELP ME

APRIL 24,  2009 AT 5:59 PM

Vimalesh Narayan said...

fOR 1st Anonymous ... Have you ever tried Opera or Firefoz browser ? .. try it and then tell me ..!

For 2nD Anonymous ... i am not sure which key you are talking about ... so be specific ...also you may not be

following the procedure carefully ...so Please let me know your mail id so that i can mail you some important map

making videos...

Also for Both of you ... Please dont post as anonymous coz it makes me difficult to address you guys... and There is

no harm in asking questions with some identity...!
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Hope this Helps..u.!

APRIL 24,  2009 AT 10:55 PM

Ihsan Berahim said...

This comment has been removed by the author.
MAY 9,  2009 AT 10:44 PM

Ihsan Berahim said...

hello guy...i have 2 problem to solve

1. no STEAM direcroty in my computer

2. my Cstrike maps directory adress

Like This "E:\Program Files\Counter Strike 1.6 Reloaded\cstrike\maps"

MAY 9,  2009 AT 10:46 PM

Vimalesh Narayan said...

you dont need to have steam to make counter strike map... you just need to configure your

HL hammer editor properly .... search youtube.com

with phrase "HL hammer configuration"...and understand it and start making u r first map..!

This tutorial will be updated soon..!

MAY 10,  2009 AT 8:50 AM

Unknown said...

This comment has been removed by the author.
JUNE 25,  2009 AT 10:14 PM

Unknown said...

Hey, i trying to create the map but if i go to the entery tool i don't see what you guys say. If I click at toEntity it says:

'There are no eligible selected objects' And i just can't find 'ambient_generic' what i have to do. And the camera is

just working 1 time because i pressed delete now i can't get it back:S?

JUNE 25,  2009 AT 10:15 PM

Reinhard Hermanus said...

i uh .. i dunno where to start i made lots of mistakes. okay first one i don't understand is the water or beer thingy in

step 5. i can't follow that step so i decided to skip it. then the second is on the 7th step. i don't understand the

mapname.bat, what i do understand is that i have to create a new text document and name it mapname.bat (i did it),

then i'll have to right click on it and edit (i did it), as expected notepad gave me blank .. then? what should i copy? all

the red marks and yellow marks? or pick one? and also my location is C:\Program Files\Counter-Strike 1.6 is that

ok? i found no half-life.

SEPTEMBER 23,  2009 AT 5:36 PM

Mikilos98 said...

Guys, i got a problem at line:

"hlrad de_test (name of my map, I DID PUT IT EVERYWHERE, checked 500000 times) and it always says:

Command line: hlrad de_test

>>There was a problem compiling the map

>>Check the file de_test.log for the cause

The log file has exactly the same copied text, what should i do?

MARCH 6, 2011 AT 2:30 AM

Mr.Kapil said...

i want to know that how can we put guns in map itself

like in map aa_dima and aim_headshot

NOVEMBER 30,  2011 AT 1:22 PM

nNn* said...

Learn how to create map http://ur-planet.blogspot.com/2011/12/how-to-make-map-of-counter-strike-16.html

DECEMBER 20,  2011 AT 6 :45 PM
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arik_pro said...

Go to www.gamebanana.com to publish your maps. Go to www.cstrikemapping.blogspot.com to learn about counter

strike 1.6 mapping.

FEBRUARY 12 , 2012 AT 12:31 PM

TIny said...

This comment has been removed by the author.
FEBRUARY 14 , 2012 AT 1:58 AM

kajmak said...

hello i have a problem . when i try to import a map, you know mpname.bat it shows a problem (Don't send ) you

know that bug what to do !?

FEBRUARY 19 , 2012 AT 7:24 PM

arik_pro said...

There is a blog where you can learn cs 1.6 mapping from start to finish. Its cstrikemapping.blogspot.com

FEBRUARY 26 , 2012 AT 12:07 PM

RageKiller said...

hey please help.. i followed all your instructions... but when CS starts in gives me this error

map change failed: 'mapname' not found on server.

At first i thought it was not able to find the mapname file so i pasted the entire directory but still im getting the same

error after CS starts. Except this time the full directory name is mentioned instead of just "mapname"

APRIL 28,  2012 AT 10:41 AM

Pradeep MH said...

awesome said ! But no mood to do all that ! Lets play what maps we have :P

Trooooollllled

AUGUST 30,  2012 AT 2:41 AM

C said...

Cara merubah skin atau textur pada game

http://christiandwiwijaya.blogspot.com/2012/11/cara-mengedit-skin-counter-strike-cs-16.html

NOVEMBER 25,  2012 AT 3:00 PM

Unknown said...

In The Box On The Right There Is Entities But No Ambient Generic and the whole list is empty Please Tell Me What

The Problem Is :(

FEBRUARY 2,  2013 AT 4:10 PM

Norbert said...

wau so usefull articel http://www.extracounterstrike.com/ about counter strike maps

FEBRUARY 9,  2013 AT 8:36 PM

Unknown said...

Sorry, but I´m don´t good speak English. I´ve got a problem. The all maps have got format .bmp. My maps have got a

format .map, .max, .rmx. What should I do???

FEBRUARY 26 , 2013 AT 10:24 PM

shri said...

go to programfiles/valve/cstrike:(or your counter strike directry) ...........there you will find all necessary files

MARCH 22,  2013 AT 12:09 AM
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Pathmal Gamage said...

Very nice and clear instructions. Thanks in advance for that. I created my 1st map and compiled successfully, Also

the map loaded in the cs game without any problem. but when the game starts map becomes wired. can not see

anything clearly, why is this. Please see the screen shot.

http://i46.tinypic.com/2efp0k5.jpg

pls advice me

what i made is a smallroom.

APRIL 9,  2013 AT 8:34 PM

Rushi said...

i made a map but light is not comming even if i put light ,plus the players are not moving

APRIL 21,  2013 AT 8:06 AM

Unknown said...

Hey plzz help ! When it compiles it shows Error : The brush uses is out of the world!

JULY 5, 2013 AT 4:00 PM

pratik said...

I am getting the mapname.err issue ... how am i supposed to deal with it ??? -Pratik aka Sniper

OCTOBER 12,  2013 AT 12:37 AM

Unknown said...

the system cannot find the file specified what have i done wrong ?

NOVEMBER 13,  2013 AT 1:36 PM

Unknown said...

I created a map but I am facing one problem during consoling. The error file shows it as:

hlvis: Error: Portal file 'e:\valve hammer editor\maps\counter-strike 1.prt' does not exist, cannot vis the map

How to solve this error?

JULY 29,  2014 AT 8:23 PM

alrazi said...

their are no properties to show "no properties available"

APRIL 28,  2015 AT 2:24 PM

Unknown said...

Download New CS Go Hacks 2015 Free Working Here:

http://dlhack.com/download/cs-go-hacks

http://dlhack.com/download/cs-go-hacks

http://dlhack.com/download/cs-go-hacks

http://dlhack.com/download/cs-go-hacks

http://dlhack.com/download/cs-go-hacks

http://dlhack.com/download/cs-go-hacks

http://dlhack.com/download/cs-go-hacks
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